18 I Windows

This chapter explains the "Window Display" feature in GP-Pro EX and the basic
management information. Please start by reading “18.1 Settings Menu” (page 18-2) and
then turn to the corresponding page.
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Settings Menu

18.1

Settings Menu

Creating Windows

Window.

Create and register the contents to display on the

Window Creation Screen

& Setup Procedure (page 18-5)
&~ Introduction (page 18-4)

Displaying Windows

Active Screen

Beep

Active Screen

Window Beep
1 =

Touch and...

The Window is called

and displayed. Check
the Window, touch the
switch again and...

Active Screen

The Window
disappears.

& Setup Procedure (page 18-8)
&~ Introduction (page 18-7)

Changing the Displayed Window

(o ) (oo )

Active Screen 1

Active Screen 1

Active Screen 1

Window » Window » Window
1 2 3

& Setup Procedure (page 18-12)
¥~ Introduction (page 18-11)

Address |Value
y D100 1 | 4 Display Control
Qjmg D101 | 1 |<Screen No.
D102 | 400
D103 | 300
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Settings Menu

Displaying the Same Window on All Screens

& Setup Procedure (page 18-15)

;Even if the screen changei ¥~ Introduction (page 18-14)
Active Screen 1 Active Screen 1 Active Screen 2
Beep » Window » Window
Cca T =g 1
Touch and... The Window can be Even if the screen

called and displayed. = changes, the same
Window is displayed.

Changing the Displayed Window on All Screens

& Setup Procedure (page 18-18)

Even if the screen Even if the screen .
} changes l } changes l % Introduction (page 18-17)
Active Screen 1 Active Screen 2 Active Screen 3
Window Window Window
1 1 1

/ Address |Value

N D116 1 | < Display Control
D117 1 | 4Screen No.

D118 | 200

D119 | 100
’ D117 :
Even if the screen Even if the screen

changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
2 2 2
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Creating Windows

18.2 Creating Windows
What is a Window?
Normal Active Screen Normal Active Screen
Process
\\//\I/mgg/ Beep
¥
the process. understood!
Screens not frequently used can be saved as Windows and displayed and hidden with a
switch. Windows are appropriate for reference or error screens.
18.2.1  Introduction

Create up to 2000 Window screens in a project to display information inside a window.

Window Creation Screen

~
S Z

ik T

Windows can be set as Local or Global.

Display Method

Display as a Local Window

Screen 1 Screen 2 | Window
Window Window 3
1 Window 1

2

Displays the set Window on a single screen.

&~ “18.3 Displaying Windows” (page 18-7)

Display as a Global Window

(Even if the screen change%

Screen 2

1

the window s/t’ays.
(

Screen 1

Window
1

Displays the Window on all screens.

&~ 185 Displaying the Same Window on All
Screens” (page 18-14)
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Creating Windows

18.2.2  Setup Procedure

Create a new Window Screen.

1 Fromthe[Screen (S)] menu, select [New Screen (N)] or click i= . The[New Screen] dialog
box appears.

Screen (50

|E Mew Screen (M)

L Open Screen (O
Cloze Screen )

=4

Screen Information (D
Chanee Wiew () 3

Reeister Template (T}

2 From [Screen Type], select [Window]. The [Screen No.] isfilled in starting from 1. You can
change this number, but the number can not be duplicated.

#* New Screen

Goreens of Type  |Window Screen: =
Sicreen E|Z ﬂ

Title [Untitled
|tz Template

Select Template from List
Becently Used Template

Cancel

3 Click [New]. The window appears.

B Base 1{Untitled) EE Window Screens 1{Untitled) |
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Creating Windows

4 Adjust the window size.
Hover over a corner, the cursor changesto L . Drag to change the size.

o It

o -

» Ensure that the Window does not exceed the size of the Base Screen.

5 Place parts on the screen as necessary. You can use the same steps as creating a base screen.

Save the window.
Click = to closethe Window.

» The Window appearsin the [Screen List]. Click the Window to view and edit

.

Screen List
Screens of Tvpe Al -
Search method ’h‘

Fefine Search
BoRX| 2 &%

=N
4> Baze Soreens

a E aom {Untitled

q':. Window Screens

= E 0001 {Untitled
N

q':. Logics
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Displaying Windows

18.3 Displaying Windows

What is a Local Window?

Screen 1 Screen 2 | Window

1 1

A local Window can be referenced from one Base screen. You can use up to three Windows
on a Base screen.

18.3.1 Introduction

A Loca Window is used as a reference window or error window from one Base screen. The
Base screen remains and the Local Window appears on top.

Active Screen Active Screen Active Screen
Beep Window Beep
Ca Cs
Touch and... The Window is called The Window disappears.

and displayed. Check the
Window, touch the switch
again and...

* You can use a switch or a designated address in the device/PLC to turn the
Window ON or OFF.

When using multiple Windows on a Base screen, the most recently displayed Window is on
top. You can move to another Window by touching the Window you want to view.

Active Screen 1 Active Screen 1 Active Screen 1 Active Screen 1
Window Window W”;jo"" Window W'”2d°"" Window V'”ch’w
1 Beep 1 1 1
(- () OO ()
If you open a Window The new Window will be Touch the Window in the That Window is now on
when another Window is on top. back and... top.

already open...
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Displaying Windows

18.3.2  Setup Procedure

 Please refer to the settings guide for details.
§~ «18.7 Window Part Settings Guide” (page 18-21)

« For details of the part placement method and the address, shape, color, and
label setting method, refer to the " Part Editing Procedure”.

&~ «9.6.1 Editing Parts” (page 9-38)

Create a Window to call from a Base screen.

Active Screen Active Screen Active Screen
Beep Window Beep
G 1
Touch and... The Window is called The Window
and displayed. Check disappears.

the Window, touch the
switch again and...

1 From the [Parts (P)] menu, select [Window (W)] or click £3 . Place the Window on the
Base screen. On the GP, the window is represented as a rectangle with a dotted line.
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Displaying Windows

2 Click the new part. The following dialog box appears. On the [Basic Settings] tab, from
[Window Type], select [Activate Switch].
Select [Activate Switch] from [Window Type].

.j‘_": Window Screens

Parts ID Basic | Switch |

WD_DDDD =
‘Window Type Activate Switch -

Comment

Window Mumber E ﬂ

[v ‘Window Interchange

Window Screen Mumber

|»

4l

1: Untitled

Help (H

3 Set the [Window No.] to "1". (Or click the scaled-down window to display from the
[Window Screen No.].)

4 On the [Switch Settings] tab, set the switch shape, color, and label.

.j‘_": Window Screens
Parts ID Bazic Switch ]
D_0000 -
v Use the Show Window Switch
Comment
Switch Label
Font Type Standard Font »|  Label
Dizplay -
Larguage |'°'SOH J o/
Tewt Color |7 ~| I0FF
Select Shape
Switch Colar

Eorder Golor —7 - Elink. MNane -
Dizplay Calor /= - Elink MNone -

Pattern | Maone j

Help (H
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Displaying Windows

5 Click [OK]. A window with a switch attached is now set.

* Select the switch to move it anywhere on the Base screen.
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Changing the Displayed Window

18.4 Changing the Displayed Window

18.4.1 Introduction

D101 D101 :

Active Screen 1 Active Screen 1 Active Screen 1

Window » Window » Window
1 2 3

Address |Value
D100 1 | 4 Display Control
D101 1 | 4« Screen No.
D102 | 400
D103 | 300

You can set up multiple Windows for one Base screen.

* |f aswitch calls an undefined Window number, the Window is not displayed.
If another Window is displayed, it remains on the screen. Also, only one
Window appears at atime. If aWindow is displayed, it is closed before
another Window appears.
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Changing the Displayed Window

18.4.2  Setup Procedure

 Please refer to the settings guide for details.
§~ «18.7 Window Part Settings Guide” (page 18-21)

Change the displayed Window Screen according to the value stored in the word address

(D101).

D101 :

D101 :

Active Screen 1

Window
1

Active Screen 1 Active Screen 1

Window Window
2 3

Address |Value
D100 1
D101 1
D102 | 400
D103 | 300

Display Control
Screen No.

1 From the [Parts (P)] menu, select [Window (W)]. Or click theicon E3 . Place awindow on

the screen.
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Changing the Displayed Window

2 Click the new part. The following dialog box appears. On the [Basic Settings] tab, from
[Window Type], select [Activate Switch].
Select [Word Action] from [Window Type].

,i‘_"'- Window Screens
Parts ID Baszic ]
WD_DDDD =
Comment Windaw Type Wiord Action -
‘Window Gontrol Address [[PLC1]D00000 ==
‘Window Specification Conztant -
‘Window Mumber E ﬂ

Window Screen Mumber

|»

1: Untitled

Cancel |

Help (H

3 In[Window Control Address], set the word address (D100) that controls the window.

Window Contral Address |[PLO1]DEID1 (il ﬂ =
4 From [Window Specification], select [Address]. Set the [Data Type].

indom Specification Addrezs hl

‘indow Mumber |DDDEIEI'I
Windaw Dizplay .
Paozition K |DDDDDZ
v |D00003
Data Twpe Bir -

5 Click [OK]. The Window is configured according to the value stored in the address.

If you turn ON Bit 0 of the Window Control Address (D100), the Window is displayed.When
word address D101's value changes, the Window changes. When the value of word address
D102 or D103 changes, the window position changes.
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Displaying the Same Window on All Screens

18.5 Displaying the Same Window on All Screens

What is a Global Window?

ﬁven if the screen changei ﬁven if the screen changei

Active Screen 1 Active Screen 2 Active Screen 3

Window » Window » Window
1 1 1
A A
The window is called The window The window still
and displayed. stays. stays.

A Global Window is awindow common to the whole project. It is displayed if a screen
changes.
One Window can be displayed at atime.

18.5.1 Introduction

A Globa Window remains displayed when a Base screen changes.

; If the screen changes K

Active Screen 1 Active Screen 1 Active Screen 2
Beep » Window » Window
Ca
Touch and... The Window is If the screen
displayed. changes, the same

Window is displayed.
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Displaying the Same Window on All Screens

18.5.2  Setup Procedure

 Please refer to the settings guide for details.
" v5.14.6 [System Settings] Setting Guide M [Display Unit] Settings Guide” (page

5-110)
« For details about placing switches or setting addresses, shapes, colors, and
labels, please refer to "Part Editing Procedure”.
& w961 Editing Parts” (page 9-38)

When you touch a switch placed on the Base screen, the same Window is displayed on &l

SCreens.
; If the screen changes l
Active Screen 1 Active Screen 1 Active Screen 2
Beep Window Window
Ca
Touch and... The Window is If the screen
displayed. changes, the same

Window is displayed.

1 From the [Project (F)] menu, point to [System Settings (C)] and select [Main Unit Settings].
Or in the [System Settings] window, click [Main Unit Settings] and select the [Action
Settings] tab.

Display Unit

Displa;-.-'l Operatio neic I Swstem frea I Extended Settings

—Window Settings

Global Window Operation IDisabIe vI

GP-Pro EX Reference Manual 18-15



Displaying the Same Window on All Screens

2 From [Global Window Operation], select [Direct].

Digplay | Cperation  Made | Logic | Svztem F'.real Extended Settings |

—Window Settings

Global YWindow Operation Im
Window Screen mg
Digplay Poszition ¥-Coordinate mg
Digplay Position Y-Coordinate mg

3 Set the [Window Screen No.] to "1". Set the [Display Position X-Coordinate] and [Display

Position Y-Coordinate] of the Window on the Base screen.

The Global Window settings are complete.

4 Place the switch on the Base screen. Double-click the switch. The Settings dialog box

appears.

Do not place overlapping switches when displaying a Global Window.

5 Set the [Bit Address]. From [Device/PLC], select [#iNTERNAL] and designate L S0016 bit

0.

.f_‘: Switch/Lamp

Part |0

SL_0000 El:

Comment

Select Shape

[~ Mo Shape

Switch Feature | Switch Comman | Lamp Feature | Calar | Label |

W Switch Feature | — ‘ | — ‘
Mult-function List _é % L
THT =
Bit Switch  "word Screen
Switch Change

Bit Address
[HINTERMAFLSO00TEL

Bit Action

,f_": Input Address

Device/PLC | #INTERNAL =

[Ls |[oo1e00
Back Clr
7|8
4| s
1] 2
1} Ent

LS 0016 00
—I:'L Bit designation (2 digits)
Address No. Area
LS Device

6 From [Bit Action], select [Bit Invert]. Click [OK].
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Changing the Displayed Window on All Screens
|

18.6 Changing the Displayed Window on All Screens
18.6.1  Introduction

Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
1 1 1

Address |Value
D116 1 | 4 Display Control
D117 1 | 4 Screen No.
D118 | 200
D119 | 100

o D17 :
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
2 2 2

« |f aswitch calls an undefined Window number, the Window is not displayed.
If another Window is displayed, it remains on the screen. Also, only one
Window appears at atime. If aWindow is displayed, it is closed before
another Window appears.
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Changing the Displayed Window on All Screens

18.6.2  Setup Procedure

NOTE  Please refer to the settings guide for details.
" v5.14.6 [System Settings] Setting Guide M [Display Unit] Settings Guide” (page

5-110)

Change the Global Window according to the value stored in the word address (for example,

D117).
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
1 1 1

Address |Value
D116 1 | 4 Display Control
D117 1 | 4 Screen No.
D118 | 200
D119 | 100

. D117 :
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
2 2 2

1 From the [Project (F)] menu, point to [System Settings (C)] and select [Main Unit Settings].
Or in the [System Settings] window, click [Main Unit Settings] and select the [Action
Settings] tab.

Display Unit

Displa;-.-'l Operatign Ldeic I System fArea I Extended Settings

—Window Settings

Global Window Operation IDisable VI
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Changing the Displayed Window on All Screens
|

2 From [Global Window Operation], select [Indirect].

dvect ]

o -

3 Set the [Data Type].

4 Select the [System Area Settings)] tab.

Mumber of words n uze: 0

G
r
G
[ st
r
i
]
G
r

I it St Erdl
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Changing the Displayed Window on All Screens

5 In[System Area Device], select the appropriate device that uses the system area. In [System
Area Start Address], define the top address.

Dizgplay Unit

Dizplay ] Ciperation ] Mode ] Logic System Area l Extended Settings ]

Dizplay
System Area Device |PLO1 ﬂ

Svstem Data Area

(System frea Start Address |[PLO1]DIJEI1 oo @)
Read Area Size p E|: ﬂ

6 Select the following check boxes: [Enable System Data Area], [Window Control], [Window
Screen No.], and [Window Display Position].

(|7 Enable System Data drea )
Swstem Data Area ltems Mumber of Wards in uge: 20
¥ Current Screen: (1 Ward) [PLCTID00100
¥ Error Status: {1 Ward) [PLCAIDO0IO
¥ Clock Data (Current): @ Ward) [PLC1]D0M 02
V¥ Status: {1 Word) [PLCAID00106
[v Reserved thkited: O Word) [PLCA 000107
¥ Change-To Screen: {1 Word) [PLCAID00108

¥ Screen Display OMAOFF: O Word) [PLC1]D00109
[¥ Clock Data (Preset Valuek @ 'Ward)  [PLCIIDOOIO

[ Contrak {1 Word) [PLCIIDO0T14
[¥ Reserved (Read): O Word) [PLC1ID00T1S
v Window Caontrak € Word) [PLC1]D00116
[V Window Screen: (1 Ward) [PLCAIDO0N?

[v ‘indow Display Position: & Words) [PLCA 1000118

The Global Window (Indirect designation) settings are complete.

When bit 0 of the Window Control Address (e.g.: D116) specified in [System Area Device]
turns ON, the Window is displayed. When the Window address (for example, D117) value
changes, the screen changes. When the value of the display coordinate address (for example,
X-coordinate is D118, Y-coordinate is D119) changes, the Window position changes.

* For details on the System Data Area, please refer the pages relevant to your
connected device in the "GP-Pro EX Connection Device Manual".
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Window Part Settings Guide

18.7 Window Part Settings Guide

The Window part is used to display a Local Window on a Base Screen.
Place a Window part on the Base Screen to display the Window in that location.

Parts ID \ Basic |
e ‘Window Type IElit Action VI
I—
Window Trigeer Bit Address |[PLO1 100000 LI@
Window Mumber I E g
W Window Interchange [ Gontinuous Read
Window Screen Mumber
Help (H | Cancel
——
Setting Description
Part ID Parts are automatically assigned an 1D number.

Window ID: WD_*x*xx*(4 digits)
Theletter portion isfixed. The number portion can be modified from 0000
to 9999.

Comment The comment for each Part can be up to 20 characters long.

Window Type Choose the control method for displaying/hiding the Window.

* Bit Action
The Window display is controlled by a specific bit address turning ON/
OFF.
&~ «18.7.1 Bit Action” (page 18-22)

* Word Action
The Window display is controlled by a specific word address.

&~ «18.7.2 Word Action” (page 18-23)

* Activate Switch
The Window display is controlled by touching an exclusive switch.

¥~ «18.7.3 Activate Switch” (page 18-25)
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Window Part Settings Guide

18.7.1 Bit Action

B Basic Settings

Baszic ]

‘Window Type Bit &ction -

Window Trigeer Bit Address [[PLGTIX00000 ==
Window Mumber E ﬂ
[v Window Interchanee [ Contihuous Read
Window Screen Mumber

Setting Description

Window Trigger Bit
Address

Specify the bit address to control the window display.
This can be set to either aPLC address or GPinternal device (System Data
Editor).

* When many parts are running from awindow, you can sometimes speed
up screen display by designating GP internal device addresses.

Window No.

Specify the number of the Window Screen you want to display from 1 to
2,000.

Window Interchange

Select this check box to allow the selected Window to move on top of
another Window.

Continuous Read

Select to continually read data from a part regardless of the Window
displayed. This does not apply to touch input parts.
When awindow is displayed, the part's Data Display speed is increased.

* When the Window is not displayed, part data specified on the window
and screen isread. All the other screen display speeds decrease.

 Up to three Windows with [Continuous Read] can be placed on asingle
Base screen. Other Windows where [ Continuous Read)] is not set cannot
be displayed. When using Global Windows, you can place up to two
windows on a Base screen.

» Windows with the [Continuous Read] option set are read before
Windows without this option are read.

» Any scripts set on a Window execute if the script condition is satisfied,
even if the Window is not displayed. If you do want to execute the script,
make sure the [ Continuous Read] check box is cleared.

Window Screen No.

Display alist of the Windows.
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Window Part Settings Guide

18.7.2 Word Action

W Basic
Basic
Window Type W
Window Gontral Address |[F‘LO1]DUUDDD ;I@
‘Window Specification Im
indow Mumber Iﬁg
Window Screen Mumber
Setting Description
Window Control Specify the word address to control the Window.
Address Set to either a PLC address or GP internal device (System Data Editor).
15 2 1 0
‘ Reserved (0) | ‘ ‘ ‘
Window Interchange J
"0": Interchange enabled
"1": Interchange disabled
"0"—"1"Display window
» When many parts are running from awindow, you can sometimes speed
up screen display by designating GP internal device addresses.
Window Select the method to display the Window.

Specification

For [Constant] For [Address]

Word Address Control Address Word Address Control Address

+1 Reserved +1 Window Screen No.

+2 Reserved +2 Display Position (X
Coordinate)

+3 Reserved +3 Display Position (Y
Coordinate)

« Constant
Set the Window No.

* Address
Four consecutive words are used starting from [Window Control
Address], the Window No. and position are stored and designated
indirectly.

& « ¢ Address Designation” (page 18-24)

Continued
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Window Part Settings Guide

Setting

Description

Window No.

Specify the number of the Window to display. The value can be from 1 to
2,000.

Window Screen No.

Displaysalist of existing Windows. Select a Window by clicking it.

€ Address Designation

Window Control Address |[PLO1]DDDDDD ;l@
Window Specification Iﬂddress vl
Window Mumber |Do00m
Window Display .
Pozition A IDDDDDE
v 000003
Data Twpe Ein -
Setting Description
Window No. Shows the address ([Window Control Address] + 1) that stores the

Window to display.

Window Display
Position

(X Coordinate/Y
Coordinate)

Displays the address that stores the window position. The X Coordinate:
[Window Control Address] + 2. TheY Coordinate: [Window Control
Address] + 3.

This stores the coordinate data of the Window's top-left corner.

X Coordinate
“« >

Y Coordinate I

Window

Base Screen

Data Type

Select the type of data to storein the address from [Bin] or [BCD].
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Window Part Settings Guide

18.7.3  Activate Switch
B Basic Settings

Basic | Switch |

‘Window Type Activate Switch -

Window Mumber lﬁﬂ
[V Window Interchange
Window Screen Mumber
Setting Description
Window No. Specify the number of the Window Screen you want to display from 1 to
2,000.

another Window.

Window Interchange | Select this check box to allow the selected Window to move on top of

Window Screen No. | Display alist of the Windows.
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Window Part Settings Guide

B Switch Settings
When the [Window Type] is set to [Activate Switch], aswitch can be used with the Window.

.i‘_‘: Window Screens

Parts ID Bazic Switch ]

D_0000 -

Comment

e

v Use the Show Window Switch

Switch Label
Standard Font = Label

| AsCT = oy
—7? - OFF

Font Twpe

Dizplay
Larguage

Text Color
Select Shape
Switch Colar
—17 - Blink

Maone hd
Maone hd

Eorder Golor
/2 - Blink
| Maone j

Dizplay Color

Pattern

Help (H

Description
Select a switch to display/hide the Window. The switch is automatically
placed in the top-right of the window. You can move it by selecting it.

Select the font type that will be displayed on the Switch label.

 Standard Font
For abit map font, you can choose the magnification level of the
letters’ height and width. When you magnify/shrink the letters, the
outline may become rough or the letter may appear squished.

* Stroke Font
Thisis an outline font where the ratio of the character height/width is
fixed. The letters will have a smooth outline even if you magnify/
shrink them. However, this font uses more disk space on the GP.

Setting
Set the Show Window
switch

Switch
Label

Font Type

Display
Language

Select the display language for the label from [ASCII], [Japanese],
[Chinese (Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or
[Thai].

Text Color

Select acolor for the label text.

Label

Type the switch text.

Continued
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Window Part Settings Guide

Setting Description
Switch Border If the Part Shape is set to have a border, select a color for it.
Color Color
Display Select the Switch color.
Color
Pattern Select from the 8 patterns or choose [No Pattern].
Pattern If a pattern has been selected, choose a pattern color.
Color The Switch color appears as a combination of the [Display Color] and
[Pattern Color].
Blink Select the Part blink and blink speed. You can choose different blink

settings for the [Border Color], [Display Color], and [Pattern Color].

» There are cases where you can and cannot set Blink depending on the
Main Unit and System Settings' [Color Settings).
&~ w951 Setting Colors M List of Available Colors” (page 9-34)
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Restrictions for Windows

18.8

Restrictions for Windows

18.8.1

Restrictions for Window Screens

Up to 2,000 Window Screens can be registered.
New windows cannot be placed over the window display. A window part, Special Data
Display [File Manager], VMUnit Display, RPAWiIndow Display cannot be placed on the
window display.
When placing aHistorical Trend Graph, Data Block Display Graph, Data Display, or
Special Data Display [Show CSV] on a Window, the following restrictions apply.
¢ Historical Trend Graph, Data Block Display Graph
A maximum of 8 Historical Trend Graphs and Data Block Display Graphs can be displayed at the same
time on asingle screen.
Also, up to 40 channels can be displayed on one Window.
¢ Data Display
You cannot input from a popup keypad into a Data Display placed on aWindow. To input datainto a Data
Display on a Window, directly place the keypad in the Window.
» Special Data Display [Show CSV]
You can not edit data. (CSV edit screen will not function.)
When 384 parts are already placed on the Base screen and Window combined, additional
placed parts will not function. Parts become disabled starting with parts placed on the last
displayed window screen.
When more than 512 Moving Mark display positions are on the Base screen and Window,
subsequent positions are disabled. They become disabled starting with marks placed on
the last displayed window screen.
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Restrictions for Windows

18.8.2  Restrictions for Window Displays

» Multiple Local Windows can be placed on the same Base screen, but a maximum of three
Local Windows can be displayed at the same time. One Globa Window and two L ocal
Windows can be displayed simultaneously on the same screen. For more details, please
refer to “ M Displaying Multiple Windows on a Single Screen” (page 18-30) .

Local Window Local Window
3 3
Local Window Local Window
2 2
Local Window
1
» Only one Global Window is allowed in each project.

*  When the Window No. is not set, the Window cannot be displayed.

*  When aWindow has been positioned to stick out past its Base screen, the Window is
adjusted to fit inside the Base screen.

* A window's size and display position go in four dot increments for the X coordinate and one
dot incrementsfor the Y coordinate. When the designated X coordinate is nhot a four dot
increment, the left side is adjusted to display as afour dot increment.

Base Screen Base Screen

Global Window

1

4 dots 4 dots
Auto correct 'olm!

V\:Vindo:w

» If multiple devices/PL Cs are connected, only the device/PLC specified in the GP System
Data Area can display Globa Windows.

» A Global Window cannot be displayed when the device monitor is on.

» When using a Switch to display awindow, if the Window part specified in [Window ID]
is used multiple times on the same screen, the first window is displayed. All other
registered windows do not function.

» Partson screens that are completely hidden by an active Window can not be activated by
touch. However, if only a portion of a part is hidden by a Window, the viewable portion
can be activated by touching it.

» Up to three Windows with [Continuous Read] can be placed on a single Base screen.
Other Windows where [ Continuous Read] is not set cannot be displayed. When using
Global Windows, you can place up to two windows on a Base screen.

» Any scripts set on aWindow execute if the script condition is satisfied, even if the
Window is not displayed. If you do want to execute the script, make sure the [ Continuous
Read] check box is cleared.
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B Displaying Multiple Windows on a Single Screen

In addition to the Global Windows/Local Windows that can be created, there are also screens
that are handled as a system window.

Target No. of Windows that can be displayed on 1 screen

User  Local Window One Global Window and two Local Windows can be displayed
Window |« Global Window simultaneously on the same screen.

e e

Screen 1 Screen 1

Local
Window 3

Local
Window 3

Local
Window 2

Local
Window 2

Global
Window 1

Local
Window 1

\ \

Special | * Security Password | You can only display one Special Window.

Window Input Screen p N [ ~

e Detailed Error Local Screen 1 Local Screen 1
Window Window 3 Window 3

» Data Display Pop- Local Local
up keypj)j & Fop Window 2 Window 2

. SpeCIaI Data .Local ,Local Detailed
Display [Show Window 1 Window 1 WE%')?
CSV] edit screen e

. Specaal Data | Communication ErrorXXXXﬁ ‘ L )
Display [File _ .
Manager] Touch the error message to display the error details.

* Video Module However, if the maximum number of User Windows are not
Display currently displayed, multiple Special Windows can be

* Remote PC Access | displayed by using Local Windows.
Window Display

(] Red border indicates Special Window

Local Screen 1 Screen 1

Window 1 Data
Display

File Manager
Display Switch Detailed

Error
E Window (=

Up to two more Function Windows You can display the File Manager
can be displayed with a Local and a Pop-up keypad.
Window...

* When the Security Password Input Screen is displayed,
other features cannot be displayed in a Window.

Continued

File
Manager

Detailed
Error

Alindaia J,
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Target No. of Windows that can be displayed on 1 screen
Special | * Security Password | When a high-priority function on a Window occurs, alow-
Window Input Screen priority function on another Window is stopped and the
* Detailed Error Window is closed. The Window with the high-priority function
Window appears.
» Data Display Pop- | - ovi Priority Order
up keypad
» Specia Data 1 Security Password Input Screen
Display [Show 2 Detailed Error Window
CSV] edit screen 3 « DataDisplay Pop-up keypad
. Special Data » Specia Data Display [Show CSV] edit screen
Display [FiIe » Specia Data Display [File Manager]
Manager] Local Screen 1 Local Screen 1
* Video Module Window 3 = | || Window 3 (—
Display Local eass Local
* Remote PC Access Window 2 Window 2
Window Display . -ad Local ‘
Window 1 | ¥P Window 1 | Detailed
Error
Window
| Communication Error XXXXﬁ X | )
Touch the error message while a The pop-up keypad closes and a
pop-up keypad is displayed and... detailed error window displays.
MPORTANT |
» A Special Window has a higher priority display function than
a Global or Local Window. Therefore if a File Manager
(displayed as a Local Window) overlaps a Detailed Error
Window, the File Manager is hidden under the Detailed Error
Window.
System |« Error Messages These Windows are displayed regardless of the status of the
Window | e Banner Alarm Global, Local, or Special Windows. These System Windows
Message are created by the system and do not affect the number of
» System Menu allowable Windows per Base screen.
* Japanese keypad
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